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EXECUTIVE SUMMARY 
 

 

 
This White Paper provides detailed information about how to migrate multiple user 
mailboxes from IBM Domino/Notes (NSF) to Google Apps /  Gmail.  
 
It contains recommendations about preparing the Source and Target message 
platforms/servers to ensure the proper permissions are in place, and thus 
eliminating the reliance on individual user passwords.  
 
It also provides in-depth information about specific features that alter the default 
behavior of Transend Migrator, and identifies best practices that enhance 
migration efficiency. 
 
Step-by-step instructions detail how to configure the tool and perform the 
migration from beginning to end. 
 

 
 
 
 

Need more help? 
 
If you ŎŀƴΩǘ ŦƛƴŘ ǘƘŜ ƛƴŦƻǊƳŀǘƛƻƴ ȅƻǳ ǎŜŜƪΣ ǇƭŜŀǎŜ ǾƛŜǿ ǘƘŜ IŜƭǇ CƛƭŜΣ ǿƘƛŎƘ Ŏƻƴǘŀƛƴǎ 
the most detailed information about every feature within the tool, including 
additional best practices.  
 
Please also contact us directly to get answers to your questions, as well as inform 
ǳǎ ƻŦ ǿƘŀǘΩǎ ƳƛǎǎƛƴƎ ƛƴ ǘƘƛǎ ²ƘƛǘŜ tŀǇŜǊ ς ǿŜΩǊŜ ŀƭǿŀȅǎ ƭƻƻƪƛƴƎ ŦƻǊ ǿŀȅǎ ǘƻ ƛƳǇǊƻǾŜ 
our offering, and documentation is an important piece of the puzzle. 
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Section 1:   Introduction 
 
This Technical Reference Guide details how to perform a batch migration of the following data types 
using Transend Migrator: 
 

ü Email Messages/Folders ü Calendar Entries 
ü Address Books ü Tasks/To Do Items 

 
For more detailed information about your specific application, security requirements, and additional 
migration options, please review the Help File. The Transend Migrator Help File is context sensitive. 
Selecting a help button will take you to the specific section in the Help File related to the screen you are 
in. 
 

Section 2:   User Interface Overview 
 
Transend Migrator contains an easy to use interface, designed to simplify the migration experience 
while allowing for maximum flexibility. Setting up your project to convert E-mail, Address Books, 
Calendars, and Tasks is accomplished within one user interface allowing you to quickly complete your 
migration in one run.  
 
Menu Bar 
 
The Menu Bar is where you will make your data type selections. The top level Menu is where you will 
find additional commands for saving configurations, setting various migration options, setting and 
viewing logging and reporting options,  and setting up batch migrations for multiple users.   
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User Interface 
 
The same interface is used whether you are migrating a single user mailbox or multiple user mailboxes 
at once (Batch Mode). Each screen for E-mail, Address Book, Calendar, or Task/To Do items is similar. 
Differences relate to the specific item types. The Email Configuration screen is shown below. 
 

 
 

1. The Top Level Menu is where you set Migration Options, review log 
files, configure batch migration data and enter your lciense information.  

 

6. The Copy Configuration button allows you to copy configuration 
information from the first screen into all other data type configuration 
screens. By default, Transend Migrator will fill in the information it can 
for you. Once you make changes, then this button allows you to update 
the other data type screens with those changes. Only similar or like-
fields will be updated. When you use the Copy Configuration button, 
you must re-enable the other data types for migration. 

2. The Buttons represent each data type available for migration: E-mail, 
Address Book, Calendar, and Task/To Do. You can migrate one or more 
data types at a time. Each data type needs to be configured individually 
and enabled individually.  A green checkmark will appear on the button 
when it is enabled for migration. 

7. The Target drop-down menu displays a list of all the available systems 
you can migrate into. 

3. The Source drop-down menu displays a list of all the available messaging 
systems you can migrate from. 

 

8. After the Target system is chosen, data entry text boxes will display. Fill 
out the information required for your target system. 

 

4. After the Source system is chosen, data entry text boxes will display. Fill 
out the information required for your source system. 

9. Enable the migration after you have configured both the source and 
target system by checking the Enable Migration checkbox. Once a data 
type is enabled a ƎǊŜŜƴ ŎƘŜŎƪƳŀǊƪ ǿƛƭƭ ŀǇǇŜŀǊ ƻƴ ǘƘŀǘ ǎŜŎǘƛƻƴΩǎ ōǳǘǘƻƴΦ 
Only the Enabled data types will migrate.  

5. The Folders button allows you to specifically choose or exclude 
individual email folders. By default, all folders will migrate. Therefore, 
you do not have to configure the source Folders list. This is optional. 

10. Select the Start Batch Migration button when you are ready to proceed 
with the migration.  
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Section 3:   Preparation of Source and Target Environments 
 
Ensuring that you are properly prepared for migration is essential to a successful migration experience.  
 

Preparing Domino/Notes for Migration 
 
The following list contains the basic requirements for migrating from Lotus Notes or a Domino Server: 
 

¶ The Lotus Notes client must be installed on the workstation performing the migration. 

¶ The Lotus Notes software should be installed into its default location, and setup as a stand-alone 
client (if you do not need to use an ID file and password). If connecting to a Domino Server then 
set it up as an active client and provide the ID file and password for the account you are 
migrating. 

¶ If the accounts are password protected then the ID file and password is required. In most cases 
ȅƻǳ Ŏŀƴ ǳǎŜ ǘƘŜ !ŘƳƛƴΩǎ L5 ŦƛƭŜ ŀƴŘ ǇŀǎǎǿƻǊŘΦ Lƴ ǎƻƳŜ ŎŀǎŜǎΣ ǎǳŎƘ ŀǎ ǿƛǘƘ ŜƴŎǊȅǇǘŜŘ ƳŜǎǎŀƎŜǎΣ 
ǘƘŜ ǳǎŜǊΩǎ L5 ŦƛƭŜ ŀƴŘ ǇŀǎǎǿƻǊŘ ƛǎ ǊŜǉǳƛǊŜŘΦ 

 
Under normal circumstances, Notes will prompt the user with a password dialog whenever a database 
or account is opened. Transend Migrator will intercept this prompt and supply the password you typed 
into the password box. In order for this interception to work, you must add one of the following 
statements into your Notes.ini file. The Notes.ini file should be located inside the Notes installation 
directory, but it could also be inside the profile directory for the logged on user. Use Windows Search if 
necessary. 

 

extmgr_addins=tmnt6.dll 

extmgr_addins=tmnts.dll (for Notes versions prior to version 6) 

 
 
 
Note 
You may also bypass the password prompt by entering the password and ID file path and filename into 
the Transend Migrator password text box.  
  

  
Syntax 
  

  
<password>;<PathAndIdFile> 

  
Example 

  
mypassword;c:\migrate\ jsnuffy.id 
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Preparing Google Apps for Migration 
 
When migrating to Google Apps or Gmail, you can specify either Google Single User, Google Apps 
(service account), Gmail IMAP (service account) or Gmail IMAP (single user).  Google Archive can be 
used as a source only from Gmail. Under either Single User mode, you must provide a password for that 
user. Under both Google (service account) options, you must create a service account in the Google 
5ŜǾŜƭƻǇŜǊΩǎ /ƻƴǎƻƭŜ ŀƴŘ !ǳǘƘƻǊƛȊŜ the service account as the administrator of the Google Apps domain 
in Google Admin Console. Under this option, you can migrate all of your users without needing the 
password for each Google user account. 
 
Administrative Service Account: OAUTH 2.0 
 
This option implements OAuth 2.0 with the service account option. Once OAuth 1.0 is no longer 
supported, this will be the only method of doing a migration using administrator credentials. You will 
grant permission to a service account to access your Google Apps data. In most cases this will be a 
service account created by you.  
 
 

For information on how to set up a Google Service Account, view the Creating a Google Service Account 
white paper. 
 

 
Transend Migrator Service Account 
 
Transend has set up an existing service account that will be used by default; however, this opens up a 
security hole, since anybody who has Transend Migrator will be able to access your data during the 
period that access has been granted to that account.  When you run Transend Migrator, this option will 
prompt you to supply your service account email, and a pathname of the private key file. Both of these 
fields may be left blank, in ǿƘƛŎƘ ŎŀǎŜ ¢ǊŀƴǎŜƴŘΩǎ ǎŜǊǾƛŎŜ ŀŎŎƻǳƴǘ ƛǎ ŀǎǎǳƳŜŘΦ  
 
Note: you still have to grant access to TǊŀƴǎŜƴŘΩǎ ǎŜǊǾƛŎŜ ŀŎŎƻǳƴǘ όŜƳŀƛƭΥ 
24974064516@developer.gserviceaccount.com), and as previously noted, this opens up your data to 
anybody with Transend Migrator so it is recommended to setup your own service account with 
administrative rights. 
 
 

For information on how to ƎǊŀƴǘ ŀŎŎŜǎǎ ǘƻ ¢ǊŀƴǎŜƴŘΩǎ Service Account, view the Granting Access to the 
Transend Service Account white paper. 
 

 
 

To use Google Apps API, configure Transend Migrator as shown with Google Apps (service account) 

Enabled the following custom option: 

Migration Options>Custom Options>Gmail/Google Apps>Authorization Service Account 

http://www.transend.com/wp-content/uploads/Setting-up-Google-Service-Account.pdf
http://www.transend.com/wp-content/uploads/Granting-Access-to-the-Transend-Service-Account.pdf
http://www.transend.com/wp-content/uploads/Granting-Access-to-the-Transend-Service-Account.pdf
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You can remove the Optional Service Account Email and Optional Private Key File fields since this 

authorization is now enabled in this custom option. 

 

1. Enter the Google Email Address for the 

user. 

2. Click Test Login and confirm that you are 

able to connect to Google after making 

these updates. 

3. Click File>Save Configuration 

 
 
 
Google Single User  
 
If you have selected Google Single User as your source or target system, the first time you perform a 
migration, you will be shown a browser window that will allow you to log on to Google. Google will then 
ask you for permission to allow Transend Migrator to access your data. Press the Accept button, and the 
migration will proceed. The next time you try to migrate the same Google user, no browser window will 
be needed, because the authorization key is stored in the registry on your computer. If you try to 
migrate a different user, then the same process will be repeated. 
 
 

1. Enter the Google Email Address 

for the user. 

2. Click Test Login and confirm that 

you are able to connect to 

Google after making these 

updates. 

3. Click File>Save Configuration 
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Click ACCEPT to allow Transend Migrator accesǎ ǘƻ ǘƘŜ ǎƛƴƎƭŜ ǳǎŜǊ Řŀǘŀ ǳǎƛƴƎ ǘƘŜ ǳǎŜǊΩǎ ƭƻƎƛƴ ŀƴŘ 

password to Google. 

 

Google Archive 
 
Google allows its users to create an archive of various types of data, including email, calendar, and 
contacts, among other types (as of this writing, tasks are not supported). An archive consists of a zip file 
containing files in industry standard formats, such as mbox, .ics, and .vcf.   Google Archive is a source 
option not a target migration option in Transend Migrator. 
 
Transend Migrator works directly with the zip file, saving you the steps of unpacking the file and figuring 

out where to store the data, and how to tell Transend Migrator where and what the data is. With this 

option, you can select "Google Archive" as the convert-from choice and have it all done automatically. 

Using a Google Archive, versus direct access, also has the advantage of allowing Google to compress the 

data on its servers before being downloaded. In contrast, if you access email, for example, via IMAP, the 

data is not compressed during transfer, and thus the conversion will be slower. In addition, no throttling 

(deliberate slowing) is done during a zip file download. 
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For information on how to create a Google Archive, view the Creating a Google Archive white paper. 
 

1. Once you have created and downloaded your archive .zip file, you may select "Google Archive" from 

Transend Migrator's email, calendar, or address book menus. Specify the name and location of the 

.zip file. For mail, you may select which folders to convert. For calendar and contacts, you may 

specify which calendar or address book to convert, or accept the default option. 

2. Click Browse to locate the downloaded Google Archive zip file. 

 

3. Click the Copy Configuration button and enable for Email, Address Book and Calendar.  

4. Click File>Save Configuration. 

  

http://www.transend.com/wp-content/uploads/Creating-a-Google-Archive.pdf
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Section 4:   Batch Migration Setup 
 
Setting up a batch process is nearly as easy as setting up a migration for a single user account. All batch 
data is stored in a Transend Migrator Data (TMD) file which contains all of the settings and options you 
have configured within the user interface. Select File | Save Configuration under the main menu to save 
all the current configurations to the default.tmd or custom TMD file. 
 
Before configuring and processing a batch migration, we recommend you first test the conversion of one 
user mailbox to become familiar with how Transend Migrator operates.  
 

Assigning Batch Variables 
 
Once you have configured and tested a single user mailbox migration, you are now ready to turn your 
project into a batch migration by assigning variables to values that can change (usually the mail 
database or source user name, password, and target accounts).  You assign these variables to values by 
populating the Batch Mode Data table. 
 
The Batch Mode Data table is located at Batch Migration | Batch Migration Setup from the main menu. 
To perform a batch migration, the Batch Mode Data table needs to be populated with all the usersΩ 
account information required for the migration. You provide this information by entering it into each 
row and column cell, or by importing a comma delimited text file you have already created. The 
information required will vary depending on the email system you use. 
 

Notice in the example, each column is 
associated with a variable, and those 
variables are $var1 through $var8. The user 
data is populated into the table, and one row 
ǊŜǇǊŜǎŜƴǘǎ ƻƴŜ ǳǎŜǊΩǎ ŘŀǘŀΣ ŀƴŘ ǘƘƻǎŜ ŀǊŜ 
the values for the variables. Once all the data 
is entered, select the OK button to return 
back to the main interface and the data type 
you are working on (E-Mail, Address Book, 
Calendar or Task/To Do). Next, substitute the 
user account information with the variables 
found on each column header. 

 
Note 
The checkboxes are in read-only mode; however, you may right-click on the checkbox and select the 
appropriate option. You may also move your cursor to the checkbox field and press the space bar to set 
or clear the checkbox. 
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Loading User Mailbox Account Data 
 
Load From File: The Load From File button allows you to load a text file, which is a comma separated 
value file, of the values you want to fill into the variables columns. In your migration, collect user data 
into a database or spreadsheet and then organize the user data by columns and rows. Extract the data 
into multiple comma separated value files (CSV) and import those CSV files by batches. 
 
The following CSV file uses the semi-colon as a delimiter instead of the comma. This is useful to use 
when a value has a comma, and when the comma cannot be used. 
 

 
 
Transend also supports uploading from an Excel Spreadsheet saved as a MS-DOS CSV file. 
 

 
 
Load From Directory: The Load Column From Directory button allows you to load file or directory 
information into the column of your choice. This feature is helpful when you have migrations based 
upon files or directories rather than from direct connections, such as with Exchange/Outlook, Lotus 
Notes, and Novell GroupWise. 
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Compare the following two screenshots to see how the variables can be used. The first screen shot 
shows the configuration of a single-user email migration. The second screenshot shows how variables 
can be inserted into the configuration screen to turn a single-user migration into a batch migration.  
 

Single User Migration Batch Migration (with Variables) 

  
 
 
The objective is to look for user data that will remain constant, and user data that needs to change. 
 
Review your data as it is entered in the Batch Mode Data table, and then substitute what needs to 
change with the appropriate variable (e.g. $var1, $var2, etc.). 
 

Validate Batch Setup 
 
Use this feature to test your batch settings before beginning your batch migration. This feature will test 
the logon for each section you specify, and for each user listed in the Batch Mode Data table. 
 
Batch Migration Setup Test 
 
 

1. Select the source and target types you want to test the 
logon for. 

2. Press the Start Test button. 
3. Review your results. 
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Batch Migration Setup Report 
 
Review the Batch Migration Setup Report results. If there are any connection failures, press the View 
Log button to review the log file generated during the test. 
 

1. Press the View Report button to view test results. The 
report is created in XML, and viewable with Microsoft 
Excel. It will list each data type tested (email, address 
book, calendar, and task), and will report the success or 
failure of the source and target connection test. 

2. Press the View Log button to view the master log file 
generated during the test. The log file is the master log 
file, and it will show the results of your validation test. 
Review this log file if you have a connection test failure, 
and look at the end of the log file for your latest test. 
Failures are recorded in red. 

 

Migrated Checkboxes 
 
The first column in each row has a checkbox that tracks which accounts have been successfully migrated 
thus far. If the box is checked it means that user has successfully migrated. You can then restart your 
migration and only migrate users who do not have a checkmark in the Migrated column. 
  
After a migration is run, all users who were successfully migrated will have their Migrated checkbox 
checked. This checkbox information is stored along with the other migration data within the TMD file. 
Therefore, it is very important to save the TMD file before and after a migration. When you exit 
Transend Migrator after a migration you will receive a warning if you have updated checkboxes and are 
attempting to exit without saving. 
  
When you run the same migration again by pressing the Start Batch Migration button, Transend 
Migrator will give you the option of converting just the unchecked entries, or to convert them all. 

 
Right click to see the options: View log for record 1, Change Migrated State, Set All Rows to Migrated or 

Set All Rows to Not Migrated 
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Enable Migration 
 
When you are finished inserting the different variables in the appropriate locations, enable the 
migration by checking the Enable Migration Checkbox. Notice, the green checkmark will appear on the 
appropriate tab after fully configuring and enabling a migration section. 
 

 
 

Copy Configuration 
 
If your migration will include Address Books, Calendars, or Task/To Do items, and those data types will 
use the same account information as Email, select the Copy Configuration button to copy your changes 
to the other data type sections. 
 

 
 
Helpful Hint 
 
It is possible you will want to migrate data that is in a different format as the email system data you are 
migrating. For example, you could be migrating email from an IMAP system, but your Address Books are 
LDIF files and your Calendar items are VCS files. Transend Migrator is very flexible and configurable to 
your unique environment. However, in this situation you would NOT want to use the Copy Configuration 
button. 
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Section 5:   Folders 
 
By default, all available folders will migrate during email conversion. You can change this behavior by 
selecting the specific folders you want to migrate or selecting specific folders you want to exclude.  
 

 
 
Folder Convert List 
 
The Folder Convert List is blank by default. When the list is blank this means that all folders available in 
the source account will migrate. You may want to press the Load from E-Mail Source button to review 
the available folders so that you can manually choose which folders to migrate. Remove a checkmark if 
you do not want a specific folder to migrate. 
 
You may also want to load the list of folders into the Folder Convert List so that you can create a list of 
folders you do not want to migrate. For example, maybe you do not want to migrate the Junk Mail 
folder for one account, or for all accounts. Right click on the folder you do not want to migrate, add it to 
the Folder Exclude List, and then press the Clear Data button to remove all entries from the Folder 
Convert List. When the Folder Convert List is empty, this tells Transend Migrator to convert all folders 
except what is listed in the Folder Exclude List. 
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Folder Exclude List 
 
You may want to exclude certain folders from being migrated. Select a specific folder you wish to 
exclude, right-click, and then choose the To Exclude List option to copy the folder name to the Exclude 
List. This is commonly used in Batch Mode so that a specific folder will be excluded for all accounts. This 
is helpful for when you want to migrate all available folders except for a select list. After adding folders 
to the Folder Exclude List, remember to clear the list of folders in the Folder Convert List. 

 

 
 
1. Enter the names of the folders you wish to exclude. 
2. Optionally, if you have a text file containing folder names to exclude you may load that list by 

pressing the Load From File button. 
3. Right Click in this window for other options on these entries. These Unicode features are helpful 

when migrating non-English character sets. 
OR 

4. Click Migration Options>Email Convert List 
5. Click Load from Source 
6. Right click and select the folder and select Add to Folder Exclude List 
7. Use the wildcard * to include subfolders 
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Folder Mapping 
 
Folder Mapping allows you to migrate a folder with a certain name into another folder with a different 
name. In many email systems, folders have similar functions yet they have different names. For 
example, new messages received into Lotus Notes are placed inside the Notes Inbox folder. In Microsoft 
Exchange, new messages received are placed inside the Inbox folder. If you want the Notes Inbox items 
migrated from the Lotus Notes Inbox into the Microsoft Exchange Inbox then create a Folder Map.  
  
You may also map to a new folder on the target email system. Enter the new name into the New Folder 
Name field and messages specified within the Original Folder Name field will migrate into that folder. 
 

Enter the folder names by putting your 
cursor into the text box and then begin 
typing.  
 
Press the Tab key to get to the next 
textbox on the list.  
 
Press Shift-Tab to go to the previous 
textbox on the list. 

 
 
 
Suggestion 
An easy way to load the Original Folder Name is to load the folder list on the Folder Convert List tab, 
right click on the folder to be mapped, and then choose the Add to Folder Map menu option. This 
feature will copy the folder name into the Original Folder Name textbox on the Folder Mapping tab.  
 
Because the folder names must be exact, adding the Original Folder Name from the Folder Convert List 
will ensure it is entered in correctly. 
 
Load From File 

You may also create a comma separated value (CSV) file containing a list of Original Folder Names and 
the New Folder Name. Save this file as a text file. Load the text file into the Folder Mapping table and 
the entries will fill into the Original Folder Name and New Folder Name fields. 
 
Example Map File 
 

The CSV file is a text file with these two values. 
Each line contains the exact name of the Original 
and Target folder name separated by a comma. 

 
Note 
If you do not want to map any folders but want to place all folders into a Group Folder, use the Group 
Folder switch found in Migration Options | Custom Options. The switch is /GN <value> where value is 
the name of the group folder.  
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Section 6:   Address Translation 
 
Transend Migrator supports address translation through the Address Translation Table. You can access 
the Translation Table under Batch Migration | Batch Migration Setup |Address Translation from the 
main menu. 
 
The Translation Table allows you to create Internet Style addresses based upon the criteria you provide. 
The Translation Table is helpful to use if you are changing the email address of your users and if you 
want Transend Migrator to make those changes during the migration. It is also helpful to use when 
migrating distribution lists and calendar attendees. 
  
Transend Migrator expects to find a match within the Address Translation Table. Changes will only be 
made to matches found. 
 
The Address Translation Table is divided into two sections. The first section is the Old Address format, 
and the second section is the New Address format you want it to be. The Old Address section of the 
Address Translation Table must be in the exact format the source application stores it. 
 
Translation Table Example 
 
Enter the Address Translation Table data into the fields provided on the Address Translation tab. You 
may also import your csv text file containing address translation data into the Address Translation 
interface. 
 

 
 
For more detail about Address Translation refer to the Transend Migrator help file. 
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Section 7:   Migrating Messages/Folders (Step-by-step) 
 
The following is a step-by-step guide of how to migrate E-Mail from Domino/Notes (NSF) to Google 
Apps/Gmail: 
 

1. Select the Email button to configure the email choices. 
2. Select Domino/Notes/NSF from the From drop down box on the Source Pane (left side of the 

screen). 
3. Enter the following information for the Lotus Notes account to be migrated: 

a. Mail Database: The location where messages are stored. This can be on the server (as 
shown in the example) or on a local hard drive. Select the Browse button if you are 
migrating a different mail file. 

b. Notes User: This information will be filled in for you. If you are migrating a different user 
or directly from a file then you might be able to leave this text box entry blank. 
Alternately, change the CN = value to the correct first and last name for that user if will 
be a different user. 

c. Password: Enter the password for the source account. If your Notes client is already 
setup for this user then just enter the password. By default, the Lotus Notes client will 
look at the user.id file and attempt to open up the account with the password you 
provided. If you need to specify a different ID file and password then use the following 
syntax, which is represented in the example shown above:  
<Password>;<PathAndIdFile.id>. 

d. Shared Folders: Enable this check box to also migrate shared folders.Select the Folders 
button to choose which folders to migrate. All folders will migrate by default if no 
folders are displayed in Email Convert List. 

4. Select the Folders button to choose which folders to migrate. All folders will migrate by default if 
NO folders are displayed in Email Convert List. 

5. From the To drop down box in the Target pane (right side of the screen) select Google Single 
User or Gmail IMAP (Single User) for single user migration.  Or use Gmail IMAP (service account) 
or Google Apps (service account) to migrate multiple users in batch mode.  

6. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service 
Account Private Key file. 

7. Insert the different batch variables in the appropriate source and target locations (if necessary). 
8. Place a checkmark in the Enable Migration Checkbox to enable Email for migration.  
9. Optionally, confgure and enable the other migration choices (Address Book, Calendar, and Task) 

if they are to be included with this migration. 
10. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
11. Once complete, select the OK button to go back to the main screen. 

 

All options implement the OAuth 2.0 protocol. The only difference is that Transend Migrator 
will connect to Google IMAP servers instead of using servers that support the Google http API. 
We have found that usually the IMAP service is faster, however it may be subject to throttling, 
i.e. a deliberate slow down by Google. 
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Domino/Notes Considerations 

Transend Migrator can migrate Lotus Notes email data whether or not the Lotus mail file is stored on 
the local workstation or if the Notes account is on a Domino message server.   
 

¶ Requirements. The Lotus Notes email client version 5.x or above is required. If the NSF file is 
protected, the ID file, account name, and password will be required to access the NSF file. If the 
NSF file is accessed via a live Domino or Foundations server then you will need the account 
information in order to access it. If the NSF file is taken from the Domino server and placed onto 
the local workstation you can bypass the need for an ID file. Normally, the NSF file is only 
protected when it is accessed through a Domino server or if the user elects to protect the file. 
Lastly, if messages are encrypted, then the ID file and password is required. 

¶ Data File. The data file is identified by the .NSF extension and the mail NSF file is based upon the 
Mail template (see Lotus Notes help for more information). 

 
It is possible to migrate an NSF file while using the Lotus Notes client to connect to a Notes/Domino 
server, or the NSF file can be taken out of the Notes/Domino server environment and migrated directly. 
Usually, this will eliminate the need for an ID file and password. If the NSF file is migrated using the 
Lotus Notes client and while connected to a Domino Server the Logon Name and ID file is needed.  
The Logon screen for Lotus Notes asks for the Notes User Name, Mail Database, and Password. The 
default values for the Notes User Name are as follows: 
 

CN=John Smith/O=Acme 
 
Where CN = the Notes User Name 
Where /0 = the Notes or Domino Server Name 
 
¢ƘŜ Ƴŀƛƭ ŘŀǘŀōŀǎŜ ƛǎ ƴƻǊƳŀƭƭȅ ǘƘŜ ƴŀƳŜ ƻŦ ǘƘŜ b{C ŦƛƭŜ ŀǎǎƛƎƴŜŘ ǘƻ ǘƘŜ ǳǎŜǊΦ CƻǊ ŜȄŀƳǇƭŜΣ ƛŦ ǘƘŜ ǳǎŜǊΩǎ 
mail alias is jsnuffy the mail database name would be jsnuffy.nsf. 
 
If migrating from a Domino server you can enter the full pathname to the NSF file or enter the default 
server path of Mail\ jsnuffy.nsf 

 
 
 
 
If migrating local nsf file, the Notes databases cannot 
have local access protection enabled.  You can check 
this by clicking on Encryption button.  Highlight the 
Notes database in the Lotus Notes client, click 
File>Application>Properties.   
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Click Encryption Settings button and confirm the Notes database has Do not locally encrypt this 
database. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If the option is already set to Locally Encrypt this database, then you will need to make new Notes 
database replicas or copies WITHOUT local access protection enabled to be able to access the database. 
 
Be sure to enable this on the Notes Client Security Prefernces when making the Notes database replica 
or copy.   
 

 
Click File>Security>User Security 
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Enter your Notes password when prompted 
 

 
 
Checkbox ς 5ƻƴΩǘ ǇǊƻƳǇǘ ŦƻǊ ŀ ǇŀǎǎǿƻǊŘ ŦƻǊƳ ƻǘƘŜǊ bƻǘŜǎ-based programs (reduces security) to create 
the notes database replicas or copies without Local Access Protection enabled. 
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Section 8:   Migrating Address Books (Step-by-step) 
 
Lotus Notes Address Book information is normally stored in a Notes Database called names.nsf; which is 
usually located on the local workstation. Address Books may also be stored in the user email file in 
$Contacts view if connected to a Domino or Foundations Start Server. If you will be using Notes or 
iNotes or Domino Web Access then we recommend that you migrate using the mail.nsf account, and 
you synchronized those contacts from the local workstation names.nsf to the mail.nsf using a Domino 
Policy. 
 

¶ Requirements. The Lotus Notes client software is required. 

¶ Data File. The Lotus Notes address book is commonly named names.nsf, and is normally kept on 
the local workstation and inside the Lotus Notes user installation folder. If you will be using 
iNotes or Domino Web Access then we recommend that you migrate into the mail account, and 
then synchronize those contacts to the local workstation. 

 
The following is a step-by-step guide of how to migrate Address Books from Notes/Domino (NSF) to 
Google Apps/Gmail: 

 
1. Select the Address Book Button to configure the Address Book choices. 
2. Select Domino/Notes/NSF from the From drop down selection box on the Source pane on the 

left side of the screen. 
3. Enter the path and filename where the names.nsf address book file is stored or select the 

Browse button to choose the file. If addresses are stored in the mail file then change the name 
database information to the location of your mail file. 

4. Select the Folders button to choose which folders to migrate. All folders will migrate by default if 
NO folders are displayed in Contacts Convert List. 

5. Select Google Single User, Gmail IMAP (Single User) for single user migration.  Or use Gmail 
IMAP (service account) or Google Apps(service account)  to migrate multiple users in batch mode 
from the To drop down selection box in the Target pane on the right side of the screen. 

6. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service 
Account Private Key file. 

7. Insert the different batch variables in the appropriate source and target locations. 
8. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration.. 
9. Optionally, confgure and enable the other migration choices (Email, Calendar, and Task) if they 

are to be included with this migration. 
10. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
11. Once complete, select the OK button to go back to the main screen. 
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Section 9:   Migrating Calendar Entries (Step-by-step) 
 
Transend Migrator converts from or to Lotus Notes Calendar items. If the account is located inside a 
Lotus Domino Server then the Calendar items will also be located on the Domino Server. If the Lotus 
Notes software is used as a stand-alone email client then the Calendar items will be located on the local 
workstation and inside the .NSF file associated with the email account. Normally, this file is found inside 
the Lotus Notes subdirectory. 
 

¶ Requirements. The Lotus Notes client software is required. 

¶ Data File. The Calendar items are stored inside the user account and inside the NSF file for the 
account. The Lotus Notes Calendar items are stored within the same file as the Lotus Notes 
email. 
 

The following is a step-by-step guide of how to migrate Calendar Entries from Notes/Domino (NSF) to 
Google Apps/Gmail: 
 

1. Select the Calendar button to configure the calendar choices. 
2. Select Domino/Notes/NSF from the From drop down selection box on the Source pane on the 

left side of the screen. 
3. Enter the Notes User Name (if required). 
4. Enter the path to the calendar file. If the Calendar file is located on an active Domino Server 

then the calendar file is normally inside the Mail\<username>.nsf file. Substitute <username> 
for the filename. 

5. Optionally, check the Upcoming events only checkbox to convert future items. Enabling this 
checkbox migrates only items originally created for future dates. 

6. Select the Folders button to choose which folders to migrate. All folders will migrate by default if 
NO folders are displayed in Calendar Convert List. 

7. Select Google Single User, Gmail IMAP (Single User) for single user migration.  Or use Gmail 
IMAP (service account) or Google Apps(service account)  to migrate multiple users in batch mode 
from the To drop down selection box in the Target pane on the right side of the screen. 

8. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service 
Account Private Key file. 

9. Insert the different batch variables in the appropriate source and target locations. 
10. Place a checkmark in the Enable Migration Checkbox to enable Address Book for migration. 

Notice, the green checkmark appears on the Calendar button after you check the Enable 
Migration checkbox. 

11. Optionally, confgure and enable the other migration choices (Email, Addrress Book, and Task), 
as described below, if they are to be included with this batch migration. 

12. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 
start and display the real-time migration progress.  

13. Once complete, select the OK button to go back to the main screen. 
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Section 10:   Migrating Tasks & To-do Items (Step-by-Step) 
 
Transend Migrator converts from or to Lotus Notes Tasks/To Do items. If the account is located inside a 
Lotus Domino Server then the Task items will also be located on the Domino Server. If the Lotus Notes 
software is used as a stand-alone email client then the Task items will be located on the local 
workstation and inside the .NSF file associated with the email account. Normally, this file is found inside 
the Lotus Notes subdirectory. 
 

¶ Requirements. The Lotus Notes client software is required. 

¶ Data File. The Task items are stored inside the user account and inside the NSF file for the 
account. The Lotus Notes Task items are stored within the same file as the Lotus Notes email. 
 

The following is a step-by-step guide of how to migrate Task/To Do Items from Notes/Domino (NSF) to 
Google Apps/Gmail: 
 

1. Select the Task/To Do button to configure the task choices. 
2. Select Domino/Notes/NSF from the From drop down selection box in the Source pane located on 

the left side of the screen, and then enter the required information for your task application. 
3. Select the Folders button to choose which folders to migrate. All folders will migrate by default if 

NO folders are displayed in Tasks Convert List. 
4. Select Google Single User, Gmail IMAP (Single User) for single user migration.  Or use Gmail 

IMAP (service account) or Google Apps(service account)  to migrate multiple users in batch mode 
from the To drop down selection box in the Target pane on the right side of the screen. 

5. Enter the Server Name, Google Email Address, Optional Service Account and Optional Service 
Account Private Key file. 

6. Insert the different batch variables in the appropriate source and target locations. 
7. Place a checkmark in the Enable Migration Checkbox to enable Tasks for migration. Notice, the 

green checkmark appears on the Tasks button after you check the Enable Migration checkbox. 
8. Optionally, confgure and enable the other migration choices (Email, Calendar, and Address 

Book), as described below, if they are to be included with this batch migration. 
9. Select the Start Batch Migration button to complete the migration. The Migration Monitor will 

start and display the real-time migration progress.  
10. Once complete, select the OK button to go back to the main screen. 
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Section 11:   Custom Options 
 
Custom Options are additional settings that allow you to alter the default behavior of Transend 
Migrator. All Custom Options are detailed in the Help File.  
 
Select Migration Options | Custom Options from the main menu in order to configure available options.  
 

 
 

Search Information 

If you want to enable an option but do not know where to find it, enter a keyword inside the search text 
box to search for the option. Transend Migrator will search for that keyword inside the entire Custom 
Options section and display the results. 
 
Select the Next button to review all the sections where your keyword was found. You may also search by 
a specific option switch (e.g. /D140). Sometimes an option can be found in two or more locations. 
Review the correct location for the option and then enable it in the source or target section related to 
your specific project. 
 
Review enabled Options by selecting the View Enabled Options button on the Custom Options screen or 
by selecting Enabled Migration Options from the View menu. These choices will display all enabled 
options by category. 
 

Commonly Used Custom Options 
 

Custom Option Switch Description 

Installation 

 Proxy Server /PROXY 
For license key verification. Internet access is required. If your network uses a 
proxy server then you will need to use this switch. 

General 

 Date Range /UADATE Migrates email, calendars, and task items within a given date range. 
 Message Date Range /MSGDATE Migrates only messages within a given date range. 

 Calendar Date Range /CALDATE Migrates only calendars within a given date range. 

Max Message Size /MAXMSGSIZE 
Set the Max Message Size as 25000 Y.Ωǎ or 25 MB which is the Office 365 
limit. If the sum of the attachments causes the entire message to exceed 
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25000 Y.Ωǎ or 25 MB, the attachments will be removed and replaced with a 
text stub. 

 Max Attachment Size /MAXATTACHSIZE 
Any attachment with a size greater than this value will be removed and 
replaced with a text stub. 

 Detach Attachments /DETACH 

Use this switch when the Max Attachment Size switch is enabled. When the 
attachment exceeds the maximum attachment size, the attachment will be 
placed into the directory specified by the /DETACH switch.  Create a directory 
on the migration workstation called c:\detach and apply a variable so each 
user has a directory for attachments, the parameter is specified as 
c:\detach\$Var1 

Recurring Calendar Entries /D127 
Recurring calendar entries will appear in the target as true recurring events, 
instead of separate individual events.   

Recurring Calendar 
entries - Expand 

/D179 
Forces calendar entries to expand where supported. 

Migrate Unique Messages /DEDUP 
Migrate unique messages and to record the MD5 hash value of the messages 
into a new or existing file. 

Deduping File Writes /D165 
Write the MD5 hash values immediately to the dedup file after each message 
instead of writing to memory. This will affect the speed of the migration, but 
allows better recovery from a crash. 

Deduping Criteria /D56 
Only used when the /DEDUP switch is enabled, and it overrides the default 
behavior. Choose which fields to run the MD5 Hash algorithm against. 

Domino/Notes Specific 

Appointments /D138 
By default, appointments are not migrated, enable this to migrate 
appointments. 

Show Views /SHOWVIEWS 
Notes Views are not enabled for migration.  To enable, checkbox this 
option and restart Transend to enable. 

Exclude All Documents /EXALL Ignore All Documents view and Discussion and Mail Threads views. 

Include All Documents /ALLDOCS 

Forces All Documents view to be processed.  This will migrate the 
Notes All Documents view as a folder and migrate each item in All 
Docs even if the item exists in another folder.  This can cause 
duplication of items since the view is now a standalone folder. 

Google Apps / Gmail 

Authorization ς Service 
Account 

/XOAUTHSA 

Enable to migrate bulk users in batch mode without having to use each user 
password. For Google Service Account email,  calendar, contacts, or tasks 
migrations, specify the service account email and path to P12 key in the form: 
service account email address|path to P12 key file 

Attachment Rename - 
Google 

/D189 
!ǇǇŜƴŘ άΦŘŀǘέ ǘƻ ŦƛƭŜ ŀǘǘŀŎƘƳŜƴǘǎ ŎƻƴǘŀƛƴƛƴƎ άōŀŘέ ŜȄǘŜƴǎƛƻƴǎΣ ǎǳŎƘ ŀǎ ΦŜȄŜΣ 
to prevent Google from rejecting the message. 

Logging / Reporting 

Debug Logging /DEBUG 
Adds additional logging to the log file, which is helpful when troubleshooting. 
It attempts to log every single step of the migration which causes the log file 
to get quite large. 

Log Subjects  Adds the Subject line information to the tmlog 

Log Time Stamps  Add the timestamp to the tmlog 

Migration Report Level /XMLREPORTLEVEL 
Use this switch and value to determine the level of detail recorded into the 
XML report. 

Throttling Options   

Maximum Stall Seconds /MAXSTALL 
Sets the number of seconds the batch mode will allow a migration process to 
be idle for before failing the migration.  Default is 180 seconds. 

Reconnect /D197 
Allows Transend Migrator to reconnect to the server when the tcp/ip 
connection fails (the default is 3). 

Timeout /TO 
Increase the Timeout when connecting to the IMAP server (default is 25 
seconds). 
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Message Deduping 
 
Transend Migrator has the ability to prevent duplicate message items from migrating. This feature is 
helpful in the event you want to restart a migration, or run a delta. It is also helpful when you restore 
many email archives from a particular person, and you want to output only the unique messages. 
 
When deduping enabled, Transend Migrator performs a calculation called an MD5 hash on each 
message item to see if it is unique. It writes that the results of the MD5 hash into memory. At the end of 
your migration, the MD5 information is taken from memory and written to file. 
 
The calculation is performed on the following metadata items to see if they are unique or different: 
 

¶ Message Body 

¶ Subject 

¶ Date 

¶ Sender 

¶ Recipient List 
 
These default metadata items can be changed, and you can also add additional requirements such as: 
 

¶ Folder 

¶ Attachment Header 

¶ Attachment Data 

¶ Unique ID 
 
Enable Deduping: 
 

1. Select Migration Options from the menu. 
2. Select Custom Options from the sub menu. 
3. Expand the General section to see the section choices. 
4. 9ƴŀōƭŜ ǘƘŜ ǎŜŎǘƛƻƴ ǘƛǘƭŜŘΣ άMigrate Unique MessagesέΦ  
5. Press OK to complete this custom option. 

 
When no parameter is entered, Transend Migrator will first write the MD5 hash value of each message 
into memory, and then write that information into a file called md5.dat, and this file will be created 
inside the same directory as the master log file (tmlog.html). 
 
Suggested Deduping Options 
 
Sometimes, a migration will fail and end abnormally. When this happens, the MD5 information in 
memory does not get written to disk. Therefore, when this happens you will have some duplicate email 
items if you decide to migrate all message folders over again. Therefore, you can force Transend 
Migrator to write the MD5 information to disk immediately instead of waiting until the migration is 
complete.  
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Deduping in Batch Mode using a Variable 
 
In batch mode, it is common practice to create an md5 hash file for each account migrated. In batch 
mode, variables are defined, such as $var1, for the name of the dedup file. Often, a variable is a user 
name so consider using the user name as the variable. It is easier to keep track of the file if it is related 
to the user name, and you will only have to use one variable. 
 

1. Turn on deduping by enabling the Custom 
hǇǘƛƻƴ {ŜǘǘƛƴƎ ŎŀƭƭŜŘΣ άaƛƎǊŀǘŜ ¦ƴƛǉǳŜ 
Items. 
 

2. Add a path and filename to the 
Parameter. Use an existing file or create a 
new file. Use the same file if you plan on 
deduping between migrations. 

 
 
 
 

3. Enable the /D165 switch, which is titled, 
Deduping File Writes. This switch forces 
Transend Migrator to write the MD5 hash 
value to disk immediately rather than 
after the migration is over. 

 
 
 
 
 

4. Optionally, enable the /D56 switch and 
then modify the default value, which is 
BSDNR. Add at the F value if you want to 
include the message folder as part of your 
deduping criteria. This might not be a 
good idea if migrating from Lotus Notes 
and you are migrating views and folders. 
This might be a good idea if you are 
migrating from another program and you 
want duplicate items in different folders. 
Perhaps, the folder is important.  
  

5. Deduping Criteria  - Use these parameters 
in the Deduping Criteria switch to choose 
which fields to run the MD5 Hash 
algorithm against 

 

Note 
You cannot share the dedup file with another process. Therefore, create a unique dedup file for each account migrated. 

F = Folder B = Message Body  S = Subject 

D = Date  R= Recipient List  N = Sender 

H = Attachment Header (name and length) 

A = Attachment Data   U ς Unique ID  
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Section 12:   Command Line Processing 
 
An alternate way of starting a batch migration is through the command line or with a batch file. Once all 
Email, or Address Book, or Calendar, or Tasks sections have been set you normally begin the migration 
by pressing the Start Single Migration or the Start Batch Migration button. You may also start a 
migration through a command line after saving your configuration using the File | Save Configuration 
AsΧ ƳŜƴǳ ŎƘƻƛŎŜΦ 
 

1. Setup a migration project for one user or for a batch of accounts. 
2. Load the user list if you are migrating in batch mode. 
3. Save your configuration by selecting CƛƭŜ μ {ŀǾŜ /ƻƴŦƛƎǳǊŀǘƛƻƴ !ǎΧ from the main Transend 

Migrator screen. Name the configuration file and keep it short. Once have saved your settings 
into a configuration file you can then run a batch migration from the command line. Review the 
Command Line Syntax & Example section for the command line detail. 

 
Command Line Syntax & Example 
 

  
Syntax 
  

  
TM12.EXE /CMDL /F <path and filename> 
  

  
Example 
  

  
TM12.EXE /CMDL /F C:\ProgramData\Transend\Project.tmd 
  

  

  
TM12.EXE 
  

  
This is the Transend Migrator executable. If you run this command all by itself then Transend 
Migrator will start in regular mode. 
  

  
/CMDL 
  

  
This switch tells Transend Migrator to run in command line mode. It expects the /F <filename> 
switch. 
  

  
/F <filename> 
  

  
The /F switch tells Transend Migrator to perform a migration based upon the settings saved inside 
the TMD filename specified. 
  

 
Additional Options 

  
/CONCURRENT <n> 
  

  
Allows # of concurrent migrations to be set through the command line rather than using the 
Migration Monitor interface. 
  

 
Note 
The command line must be executed from the Transend Migrator installation directory. It will be easier 
to create a batch file using Notepad rather than manually running it from the command line. Below is an 
example of a simple batch file: 
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1. Start Transend Migrator and configure the settings for one or more accounts. 
2. Save your configuration by selecting File | Save Configuration from the main Transend Migrator 

screen. For this example, save your configuration file into C:\Migrate\project.tmd 
3. Create a batch file and use the Batch File Example as a guide. 

 
Batch File Example 
 

 
 
Run the Batch File 
 
Double-click on the batch file using Windows Explorer. Once the batch file starts it will load the 
Migration Monitor and begin migration. When the migration completes the Migration Monitor will exit. 
 
Provide accounts in CSV file 
 
Normally, in a command line migration all your settings and account information is saved in the 
Transend Migrator configuration file (TMD); however, you may save the account information inside a 
CSV file and reference that CSV file. This is useful when you will be automating the user list extraction 
and do not have the ability to save the user information in the TMD file. The CSV file will contain the 
values for the variables you define in the TMD file. Use the /batchdata <file> switch in addition to your 
other command line switch choices. Any values declared in the TMD file will be replaced, and the values 
in the CSV file will be used. 
 
Batch File Example with CSV file containing user information 
 

Example 
TM12.EXE /CMDL 1 /F C:\ ProgramData\ Transend\ Project.tmd /batchdata 
C:\ Migrate\ Userlist.csv 

 

Section 13:   Migration Monitor 
 
The Migration Monitor displays the real-time status of all user mailboxes as they are migrated. The 
Migration Monitor is a multi-threaded process, which means that multiple accounts can be migrated at 
the same time if the email systems support concurrent migrations, and if your license permits. 
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Section 14:   Concurrent Migrations 
 
Transend Migrator has the ability to migrate more than one account at a time, and this is called 
Concurrent Migrations. During a batch process, Transend Migrator will migrate each account in entry 
order, which is defined in the Batch Mode Data table. It starts at the top and works through the list until 
the list is complete. If your license allows, you may migrate more than one account at a time. This allows 
you to complete your project more quickly. 
 
Adjust the number of concurrent migrations when you begin a migration and the Migration Monitor 
appears. Transend Migrator will default to 1 concurrent migration. Press the up or down arrow to adjust 
the number of concurrent migrations. 
 

Performance 
 
Increase the number of concurrent migrations to attain the best possible speed your system will allow. 
Each computer system is different, and each email system is different. Migrating data on a local machine 
gives you one rate of speed, while migrating across a local area network will give you a different rate of 
speed. The number of email messages and attachments will also affect your migration rate, as will the 
size of those messages and attachments. 
 
The best way to determine how fast you can perform a migration is by setting up a few test accounts 
and giving each account 1 Gigabyte of normal email data. Migrate one account at a time and review the 
rate of speed. Then, migrate the same test accounts and increase the number of concurrent migrations 
to 2, and so on. Evaluate the rate of speed and the combined rate of speed. Lower the number of 
concurrent migrations when you see a decrease in migration rate 
 

Adding Migration Workstations 
 
At some point, you will reach the maximum capability of your migration workstation, and you may want 
to add more workstations to decrease the amount of time it takes to migrate your accounts. Review 
how long it takes to migrate 1 GB of data on a single workstation, determine the number of concurrent 
migrations your workstation will allow, and then calculate how much faster your project will complete 
by adding workstations. 
 

Calculating Migration Time 
 
Below are examples of an easy way to calculate how long it will take to complete a migration. Create a 
simple spreadsheet that lists the total number of gigabytes to migrate, the quantity of workstations you 
will use, and then the rate of speed your system will migrate. Then, enter a simple formula to calculate 
how long your migration will complete with one workstation. In these screenshot examples, your 
formula would be: (όDƛƎŀōȅǘŜǎκwŀǘŜύκt/ΩǎύΦ 
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In Microsoft Excel, your formula would look similar to: =(E14/E16)/E15 

Spreadsheet Example 1 

 
 
In the spreadsheet example above, it will take 4.86 days to migrate 350 gigabytes of data at the rate of 3 
gigabytes per hour. Therefore, you may want to add more machines to complete your project in a 
shorter amount of time.  

 
Spreadsheet Example 2 

 
 
If you are using a simple formula, add more workstations to your spreadsheet to determine how much 
faster your project will complete. In Spreadsheet Example 2, the same migration will complete in 23 
hours if 5 workstations are used at the same time. Be careful when adding computers to your project, 
and verify your source/target servers and network can handle the workload. In you are migrating into 
Microsoft Exchange, we recommend you turn off Transaction Logging so that your Exchange Server will 
not become overloaded and use up too much disk space. Turn Transaction Logging back on when your 
migration project is complete. 
 

Section 15:   Schedule Migration 
 
You may schedule a migration to begin at a later time by setting the start time on the Migration 
Schedule screen. Start later in the evening when you can receive optimal performance, bandwidth, and 
no interruption. If there are other processes that must begin while the migration is running then you 
may also pause the migration, and continue after the processes are complete.  
  
You must configure your migration before you can schedule it. Pre-configure the E-Mail, Address Book, 
Calendar, and Tasks as they need to be set. Import your list of users if performing a batch migration, and 
then save this configuration by selecting File | Save Configuration from the Transend Migrator main 
menu.  
 
Caution 
Once the schedule has been set it will become effective and begin only after pressing one of the Start 
Migration Buttons. Migration will not happen if you close Transend Migrator.  
  
You do not have to set all options in the Migration Schedule. Only the values with an enabled checkbox 
will take effect after pressing the Start Migration Button. 
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Section 16:   Reporting / Logging 
 

Reporting 
 
Migration reports in XML format will be created after each successful run, and can be viewed with 
Microsoft Excel. XML reports can be found inside the default subfolder or in a folder containing the 
name of the custom configuration, and can easily access by selecting View | Migration Reports from the 
main menu. Each time a migration is run a new Migration Report will be created, and it will be assigned 
an incremental number beginning with the number 1. 
 

 
 
The default detail contained within the XML Report contains the following information: 
 

ω    User ID 
 

ω    Status 
 

ω    Database / User 
 

ω    Time Started 
 

ω    Time Ended 
 

ω    Elapsed Time 
 

ω    Folder Count 
 

ω    Email Count 
 

ω    Address Count 
 

ω    Calendar Count 
 

ω    Task Count 
 

ω    Attachment Count 
 

ω    Skipped Entries 
 

ω    Data Rate (megabytes per hour) 
 

 

Use the following switch and value to increase or decrease the level of detail in the XML Report: 
 

Switch Value Description 

  
/NOXMLREPORT 
  

  

  
Use this switch to disable XML reporting. No XML report will be produced when 
this switch is used. 
  

  
/XMLREPORTLEVEL 
  

  
<n> 
  

  
Use this switch and value to determine the level of detail recorded into the XML 
report. The default value is 1. Increase the value to 2 if you want to record Folder 
Names and Entry Counts for those folders. 
  

  
Note 
Transend Migrator reports the number of attachments converted with each message; however please 
be aware that this number may include graphic images embedded within HTML documents. Therefore, 
the number of actual attachments visible in your email client, such as Word or Excel files, may be 
different than reported. 
 










